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1.  Introduction 
 

1.1 Add-on Module STEEL Plastic 

A common way to design cross-sections is the elastic-plastic method. For the calculation of the 
internal forces Sd, linear elastic material behavior is assumed, for the calculation of the resis-
tances Rd the elastic-perfectly plastic material behavior. Thus, the reserves of the cross-section 
are used, but the possibly existing plastic reserves of the system are not considered. 

The ultimate limit state occurs when the limit internal forces in the fully plastic state are 
reached. It is necessary to verify that the internal forces under consideration of the interaction 
do not result in exceeding the limiting internal forces in the fully plastic state. 

In STEEL Plastic, the following design methods are available:  

• Cross-sections consisting of three or two plates (I-, C-, Z-, L-sections, channels, tees), flat 
steel, pipes, and hollow sections according to the Partial Internal Forces Method (PIFM) 
with redistribution by KINDMANN/FRICKEL  

• Elliptical cross-sections with analytic non-linear optimization procedure  

• Simplex Method for general cross-sections. 

For this design method, all combinations of internal forces are considered. The design ratio of 
each section is shown in the clearly-arranged tables and in the RSTAB graphic, allowing you to 
infer the utilization of certain members at one glance. For each design section, detailed infor-
mation on interaction (for example, the plastic internal forces) is shown. 

If necessary, the module carries out an optimization of the cross-sections and exports the 
changed cross-sections to RSTAB. Using the design cases, you can analyze separate structural 
components in complex structures or analyze variants. 

STEEL Plastic is an add-on module integrated in RSTAB. Thus, the design-relevant input data is 
already preset when you start the module. After the design, you can evaluate the results in the 
graphical user interface of RSTAB. Finally, the analyses can be documented in the global print-
out report, from determination of internal forces to design. 

We hope you enjoy working with STEEL Plastic. 

Your DLUBAL Team  
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1.3 Using the Manual 
Topics like installation, graphical user interface, results evaluation, and printout are described 
in the manual of the main program RSTAB. The present manual focuses on typical features of 
the STEEL Plastic add-on module. 

The descriptions in this manual follow the sequence and structure of the module's input and 
results windows. In the text, the buttons are given in square brackets, for example [View 
mode]. At the same time, they are pictured on the left. The Expressions that appear in dialog 
boxes, windows, and menus are set in italics to clarify the explanations. 

At the end of the manual, you find the index. If you still cannot find what you are looking for, 
please check our website www.dlubal.com where you can go through the FAQ pages and find a 
solution by using various filter criteria. 

1.4 Opening the STEEL Plastic Module 
In RSTAB, you have the following possibilities to start the add-on module STEEL Plastic. 

Menu 
To open the add-on module, you can select in the RSTAB menu 

Add-on Module → Design - Steel → STEEL Plastic. 

 

Figure 1.1: Menu: Add-on Module → Design - Steel → STEEL Plastic 

http://www.dlubal.com/
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Navigator 
Alternatively, you can start the add-on module in the Data navigator by clicking 

Add-on Modules → STEEL Plastic. 

 

Figure 1.2: Data navigator: Add-on Module → STEEL Plastic 

Panel 
If results from STEEL Plastic are already available in the RSTAB model, you can also open  
the design module from the panel: 

First, set the relevant STEEL Plastic design case in the load case list of the RSTAB toolbar. Then, 
click the [Show Results] button to graphically show the design criterion on the members. 

If the results display is activated, the panel is available, too. Now you can click [STEEL Plastic] in 
the panel to open the module. 

 

Figure 1.3: Panel button [STEEL Plastic] 
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2.  Input Data 
When you start the add-on module, a new window opens. In this window, a navigator is dis-
played on the left that manages the available input and output windows. The drop-down list 
above the navigator contains the design cases (see Chapter 7.1, page 38). 

The design-relevant data is defined in several input windows. When you open STEEL Plastic for 
the first time, the following parameters are imported automatically: 

• Members and sets of members 

• Load cases, load combinations, result combinations, and super combinations 

• Materials 

• Cross-sections 

• Internal forces (in the background, if calculated). 

To select a window, click the corresponding entry in the navigator. To go to the previous or 
next window, use the buttons shown on the left. You can also use the function keys to select 
the next [F2] or previous [F3] window. 

To save the results, click [OK]. Thus, you exit STEEL Plastic and return to the main program.  
To exit the module without saving the new data, click [Cancel]. 

2.1 General Data 
In the 1.1 General Data window, you select the members, sets of members, and actions that 
you want to analyze. The tabs manage the load cases, load combinations, result combinations, 
and super combinations for the various checks. 

 
Figure 2.1: Window 1.1 General Data 
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Design of 

 
Figure 2.2: Design of members and sets of members 

The design can be carried out for Members as well as for Sets of Members. If you want to design 
only particular objects, clear the All check box. Now you can access the text boxes to enter the 
numbers of the relevant members or sets of members. To select the list of the preset numbers, 
double-click in the text box and overwrite the list by manually entering the numbers. Alterna-
tively, you can select the objects graphically in the RSTAB work window upon clicking []. 

When you design a set of members, the program determines the extreme values of all mem-
bers contained in the set of members. The according results are shown in the results windows 
2.3 Design by Set of Members, 3.2 Governing Internal Forces by Set of Members, and 4.2 Parts List 
by Set of Members. 

To define a new set of members, click [New]. The dialog box already known from RSTAB ap-
pears where you can specify the parameters for a set of members. 

Ultimate Limit State - Existing Load Cases and Combinations 
This dialog box section contains all load cases, load combinations, result combinations, and 
super combinations created in RSTAB. 

To transfer the selected entries to the To Design section, click []. Alternatively, you can just 
double-click the entries. The [] button transfers the complete list to the right. 

To transfer multiple entries at once, select them while pressing the [Ctrl] key, as common in 
Windows applications. 

If a load case is highlighted in red, for example LC 8-10 in Figure 2.1, it means that it cannot be 
designed. This happens when the load cases are defined without any load data or contain only 
imperfections. When you transfer such a load case, a corresponding warning appears. 

At the end of the list, several filter options are available. They will help you assign the entries 
sorted according to load cases, load combinations, or action categories. The buttons have the 
following functions: 

 
Selects all cases in the list 

 
Inverts selection of load cases 

Table 2.1: Buttons in the tab Ultimate Limit State 

Ultimate Limit State - Selected for Design 
The section on the right contains the load cases, load combinations, and result combinations 
selected for design. To remove selected entries from the list, click [] or double-click the en-
tries. To transfer the entire list to the left, click []. 

The design of an enveloping max/min result combination is performed faster than the design 
of all available load cases and load combinations. However, the influence of the contained 
load cases and load combinations is difficult to discern. 

Comment 
In this text box, you can type user-defined notes describing, for example, the current design 
case. 

 

Result combination 
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2.2 Materials 
The window is subdivided into two parts. The upper part lists all materials created in RSTAB. 
The Material Properties dialog box section shows the properties of the current material, that is, 
the table row currently selected in the upper section. 

 
Figure 2.3: Window 1.2 Materials 

Materials that will not be used in the design are displayed in grey, materials that are not al-
lowed in red, and modified materials in blue. 

The material properties required for the determination of internal forces are described in 
Chapter 4.2 of the RSTAB manual (Main Properties). The material properties required for design 
are stored in the global material library. These values are preset (Additional Properties). 

To adjust the units and decimal places of material properties and stresses, select in the mod-
ule's menu  
  Settings → Units and Decimal Places  (see Chapter 7.3, page 42). 

Material Description 
The materials defined in RSTAB are preset but can be changed at any time. To do this, click the 
material in column A. Then, click [] or press function key [F7] to open the material list. 

 
Figure 2.4: List of materials 



2  Input Data 

 

 

 

11 Program STEEL Plastic © 2014 Dlubal Software GmbH 

 

You can select only materials from the "Steel" category. 

After you import a material, the design relevant Material Properties are updated. 

If you change the material description manually and your entry is stored in the material library, 
STEEL Plastic will import the material properties, too. 

It is principally not possible to edit the material properties in STEEL Plastic. 

Material Library 
Numerous materials are already available in the library. To open the library, select 

Edit → Material Library 

or use the button shown on the left. 

 
Figure 2.5: Dialog box Material Library 

In the Filter section, Steel is preset as the material category. Select the relevant steel grade for 
design in the Material to Select list. You can check the corresponding properties in the section 
below. 

To transfer the selected material to Window 1.2 of STEEL Plastic, click [OK] or [↵]. 

Chapter 4.2 of the RSTAB manual describes how to filter, add, or rearrange materials. 
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2.3 Cross-Sections 
This window manages the cross-sections that are used for the design. In addition, you can 
specify optimization parameters in this window. 

 
Figure 2.6: Window 1.3 Cross-Sections 

Cross-Section Description 
The cross-sections defined in RSTAB are preset together with the assigned material numbers. 

To change a cross-section, click the entry in column B, thus selecting this box. To open the 
cross-section table of the current cross-section box, click [Cross-Section Library] or [...] in the 
box or press the function key [F7] (see the following figure). 

In this dialog box, you can select a different cross-section or a different cross-section table. To 
select a different cross-section category, click [Back to cross-section library]. The general cross-
section library opens. 

Chapter 4.3 of the RSTAB manual describes how to select cross-sections from the library. 
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Figure 2.7: IS cross-sections in the cross-section library 

You can also enter the new cross-section description in the cross-section box directly. If the 
data base contains the entry, STEEL Plastic imports the according cross-section parameters, 
too. 

A modified cross-section is highlighted in blue. 

If cross-sections specified in STEEL Plastic are different from the ones used in RSTAB, both 
cross-sections are displayed in the graphic on the right. The designs are carried out with the 
internal forces from RSTAB for the cross-section selected in STEEL Plastic. 

Cross-Section Type 
The cross-section type is decisive for the design method (see Chapter 3.2, page 18): 

• Cross-sections consisting of three or two plates (I-, C-, Z-, L-sections, channels, tees), flat 
steel, pipes, and hollow sections: Partial Internal Forces Method with redistribution by 
KINDMANN/FRICKEL 

• Elliptical cross-sections: analytical nonlinear optimization method 

• General cross-sections: Simplex Method. 

Max. Design Ratio 
This table column is displayed only after the calculation. It serves as a decision support for the 
optimization. By means of the design ratio and colored relation scales, you can see which 
cross-sections are little utilized and thus oversized, or overstressed and thus undersized. 

Optimize 
Each allowable cross-section can undergo an optimization process. For the RSTAB internal 
forces, the program searches the cross-section that comes as close as possible to a user-
defined maximum design ratio. This ratio can be specified in the General tab of the Details  
dialog box (see Figure 3.2, page 17). 
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To optimize a cross section, open the drop-down list in column D or E and select the relevant 
entry: From current row or, if available, From favorites 'Description‘. Recommendations for the 
cross-section optimization can be found in Chapter 7.2, page 40. 

Remark 
This column shows remarks in the form of footers that are described in detail below the cross-
section list. 

A warning might appear before the calculation: Incorrect type of cross-section No. XX. This 
means that there is a cross-section that is not registered in the data base. This can be a user-
defined cross-section or a SHAPE-THIN cross-section that has not been calculated yet. To select 
an appropriate cross-section for design, click [Library] (see description after Figure 2.6). 

Member with Tapered Cross-Section 
For tapered members with different cross-sections at the start and end, the module displays 
both cross-section numbers in two rows, in accordance with the definition in RSTAB. 

STEEL Plastic also designs tapered members, provided that the cross-section at the start of the 
member has the same number of stress points as the cross-section at the end of the member. 
For example, the normal stresses are determined from the moments of inertia and the distanc-
es of the stress points from the center of gravity. If the cross-sections at the start and the end 
of a tapered member have a different number of stress points, the intermediate values cannot 
be interpolated. The calculation is possible neither in RSTAB nor in STEEL Plastic. 

The cross-section's stress points including numbering can also be checked graphically. To do 
this, select the cross-section in Window 1.3, and then click [Info]. The dialog box shown in Fig-
ure 2.8 appears. 

Info About Cross-Section 
In the Info About Cross-Section dialog box, you can view the cross-section properties, stress 
points, and c/t-parts. 

 
Figure 2.8: Dialog box Info About Cross-Section 
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The right part of the dialog box shows a graphic of the currently selected cross-section. 

The buttons below the graphic have the following functions: 

 

 

Table 2.2: Buttons of the cross-section graphic 

By means of the [Details] button, you can call up detailed information on stress points (dis-
tances to center of gravity, statical moments of area, normalized warping constants, etc.) and 
c/t-parts. 

 
Figure 2.9: Dialog box Stress Points of HEA 200 

Button Function 

 
Displays or hides the stress points 

 
Displays or hides the c/t-parts 

 
Displays or hides the numbers of stress points or c/t-parts 

 
Displays or hides details of the stress points or c/t-parts (see Figure 2.9) 

 
Displays or hides the dimensions of the cross-section 

 
Displays or hides the main axes of the cross-section 

 
Resets the full view of the cross-section graphic 
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3.  Calculation 
 

3.1 Detail Settings 
Before starting the [Calculation], you should check the design details. To open the correspond-
ing dialog box, use the [Details] button available in every window of the add-on module. 

The Details dialog box contains the following tabs: 

• Settings 

• General 

• Used Literature. 

3.1.1 Settings 

 
Figure 3.1: Dialog box Details, tab Settings 

Partial Safety Factor 
For the determination of the resistances Rd, the partial safety factor γM of the material is usually 
to be considered. If you Define this factor manually, it is applied globally for all materials of the 
design case. By default, however, the partial safety factors are taken separately for each mate-
rial from the properties defined in the 1.2 Materials window. 

Calculation Options 
Cross-sections consisting of two or three plates (I-, C-, Z-, L-sections, channels, tees) are calcu-
lated according to the PIFM with redistribution according to [1], elliptical cross-sections ac-
cording to the non-linear optimization method. By selecting the check box, you can calculate 
these cross-section types also according to the Simplex Method (see Chapter 3.2), which is 
usually used only for general cross-sections. 
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3.1.2 General 

 
Figure 3.2: Dialog box Details, tab General 

Cross-Section Optimization 
The optimization is targeted on the maximum design ratio of 100 %. If necessary, you can also 
specify a different upper limit in the text box. 

Display Result Tables 
Here, you can select which results windows and parts list you want to display. These windows 
are described in Chapter 4 Results. 
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3.2 Design Methods 
Depending on the cross-section type, one of the following methods is used. 

Partial Internal Forces Method (PIFM) 
According to the PIFM with redistribution by KINDMANN/FRICKEL [1], you can design cross-sections 
consisting of two or three plates: top flange, web and, if available, bottom flange. The flanges 
must be arranged horizontally, the web vertically. In this way, the most frequently used cross-
sections are considered. 

 

Figure 3.3: General cross-section consisting of three plates (horizontal-vertical-horizontal) 

If the top or bottom flange is left out, you can consider cross-sections consisting of two plates 
like tees or L-sections. 

The method by KINDMANN/FRICKEL allows you to design flat steel sections, pipes, and hollow sec-
tions. The calculation methods are described in [1], Chapter 10. 

In Chapter 8 of this manual, you find worked examples for various sections analyzed according 
to the PIFM. 

Plastic interaction relations for elliptical cross-sections 
The plastic interaction relations for elliptical cross-sections according to NOWZARTASH/MOHAREB 
are described in [2]. An analytical nonlinear optimization method is used to analyze the plastic 
capacity of elliptical hollow sections. 

 

Figure 3.4: Elliptical hollow sections with interaction from axial force, torsion, and double bending according to [2] 
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Simplex Method 
For a linear optimization problem, the cross-section is discretized into a finite number of sur-
face elements that are as small as possible. If all internal forces of an x-location are consistently 
multiplied by a factor, the plastic capacity is found for a certain value. A combination of internal 
forces can be described by means of the following vector:  

  F = {N,Mu,Mv,Vu,Vv,MT}  

In the calculation of the plastic resistance, a constant ratio of the components is assumed in 
this vector, so that the factor enlarges the internal force vector F up until the yield area. The 
factor is determined as the maximum of a linear optimization problem using a revised simplex 
algorithm. With the yield conditions according to VON MISES, we obtain a coordinate plane of 
normal and shear stresses of an ellipse which is approximated by an inscribed octagon. 

 

Figure 3.5: Linear approximation of the yield criterion 

With this method, you can analyze general cross-sections with thin-walled element thickness-
es. They are also used in the cross-section program SHAPE-THIN (see [3]). 

The Details dialog box allows you to calculate the cross-sections consisting of two or three 
plates and hollow sections according to the Simplex Method (see Figure 3.1, page 16). 
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3.3 Start Calculation 
To start the calculation in STEEL Plastic, use the [Calculation] button available in every input 
window of the module. 

STEEL Plastic searches for the results of the load cases, load combinations, and result combina-
tions selected for design. If no results can be found, the program starts the RSTAB calculation 
to determine the design-relevant internal forces. 

You can also start the calculation in the RSTAB user interface. To do this, use the To Calculate 
dialog box (menu Calculation → To Calculate), containing design cases as well as load cases or 
load combinations. 

 
Figure 3.6: Dialog box To Calculate 

If the STEEL Plastic cases are missing in the Not Calculated list, select All or Add-on Modules in 
the drop-down list at the end of the dialog box section. 

To transfer the selected STEEL Plastic case to the section on the right, click []. Click [OK] to 
start the calculation. 

Alternatively, you can start the calculation of a design case by using the drop-down in the 
toolbar. In this list, select the STEEL Plastic case, and then click [Show Results]. 

 
Figure 3.7: Direct calculation of an STEEL Plastic case in RSTAB 

Subsequently, you can observe the design process in a separate dialog box. 



4  Results 

 

 

 

21 Program STEEL Plastic © 2014 Dlubal Software GmbH 

    

4.  Results 
Immediately after the calculation, the 2.1 Design by Load Case window is shown. 

 
Figure 4.1: Results window with designs and intermediate values 

The designs are shown in the results windows 2.1 through 2.5, sorted by different criteria. 

Windows 3.1 and 3.2 show the governing internal forces. Windows 4.1 and 4.2 show the parts 
lists by members and sets of members. 

To open a window, click the corresponding entry in the navigator. To go to the previous or 
next input window, use the buttons shown on the left. Alternatively, you can use the function 
keys to go the next [F2] or previous [F3] window. 

Click [OK] to save the results. Thus you exit STEEL Plastic and return to the main program. 

Chapter 4 Results describes the different results windows one by one. Chapter 5 Evaluation de-
scribes evaluating and checking results, page 30 f. 
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4.1 Design by Load Case 
The upper part of the window shows a summary of the governing checks sorted by load case, 
load combination, and result combination. 

The lower part provides detailed information about the cross-section properties, design inter-
nal forces, and check parameters for the load case selected above. 

 
Figure 4.2: Window 2.1 Design by Load Case 

Description 
This column shows the descriptions of the load cases, load combinations, and result combina-
tions used for the designs. 

Member No. 
This column shows the number of the member with the maximum design ratio of the analyzed 
loading. 

Location x 
This column shows the corresponding x-location where the member's maximum design ratio 
occurs. For the table output, the program uses the following member locations  x: 

• Start and end node 

• Division points according to possibly defined member division (see RSTAB Table 1.6) 

• Member division according to specification for member results  
(RSTAB dialog box Calculation Parameters, tab Global Calculation Parameters) 

• Extreme values of the internal forces. 

Design 
Columns D and E show the design conditions 

The length of the color scale represents the respective stress ratio. 
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Design According to Formula 
This column shows the equations of the standard used in the checks. 

4.2 Design by Cross-Section 

 
Figure 4.3: Window 2.2 Design by Cross-Section 

This window shows the maximum design ratios of all members and actions selected for de-
sign, sorted by cross-section. 

If there is a tapered member, both cross-section descriptions are displayed in the table row 
next to the section number. 
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4.3 Design by Set of Members 

 
Figure 4.4: Window 2.3 Design by Set of Members 

This results window is displayed if you have selected at least one set of members for design. 
The window lists the maximum design ratios sorted by set of members. 

The Member No. column shows the number of the one member within the set of members that 
bears the maximum ratio for the respective design criterion. 

The output by set of members allows you to clearly present the design for an entire structural 
group (for example, a frame). 
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4.4 Design by Member 

 
Figure 4.5: Window 2.4 Design by Member 

This results window shows the maximum design ratios for the individual designs sorted by 
member number. The columns are described in detail in Chapter 4.1, page 22. 

4.5 Design by x-Location 

 
Figure 4.6: Window 2.5 Design by x-Location 
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This results window lists the maxima for each member at the locations x resulting from the 
division points in RSTAB: 

• Start and end node 

• Division points according to possibly defined member division (see RSTAB Table 1.6) 

• Member division according to specification for member results  
(RSTAB dialog box Calculation Parameters, tab Global Calculation Parameters)  

• Extreme values of the internal forces. 

4.6 Governing Internal Forces by Member 

 
Figure 4.7: Window 3.1 Governing Internal Forces by Member 

This window shows for each member the governing internal forces that result in maximum 
design ratios in each check. 

Location x 
This column shows the respective x-location with the member's maximum design ratio. 

Load Case 
This column displays the number of the load case, load combination, or result combination 
whose internal forces produce the maximum design ratio. 

Forces / moments 
For each member, this column displays the axial and shear forces as well as the torsional and 
bending moments resulting in the maximum design ratios in the various cross-section checks. 

Design According to Formula 
The final column provides information on the check types and the formulas used in the checks 
according to [1], [2], or [3]. 
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4.7 Governing Internal Forces by Set of Members 

 
Figure 4.8: Window 3.2 Governing Internal Forces by Set of Members 

This window shows the internal forces that result in the maximum design ratios in the design 
of each set of members. 
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4.8 Parts List by Member 
Finally, STEEL Plastic provides a summary of all cross-sections used in the design case. 

 
Figure 4.9: Window 4.1 Parts List by Member 

By default, this list contains only the designed members. If you need a parts list for all members 
of the model, select the corresponding option in the Other tab of the Details dialog box (see 
Figure 3.2, page 17). 

Part No. 
The program automatically assigns part numbers to similar members. 

Cross-Section Description 
This column shows the cross-section numbers and descriptions. 

Number of Members 
This column shows for each part how many similar members are used. 

Length 
This column displays the length of a single member. 

Total Length 
This column shows the product determined from the previous two columns. 

Surface Area 
For each part, the program indicates the surface area relative to the total length. The surface 
area is determined from the Surface of the cross-sections that can be seen in Windows 1.3 and 
2.1 through 2.5 in the cross-section properties (see Figure 2.8, page 14). 
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Volume 
The volume of a part is determined from the cross-sectional area and the total length. 

Unit Weight 
The Unit Weight is the weight of the section relative to the length of one meter. For tapered 
cross-sections, the program averages both cross-section properties. 

Weight 
The values of this column are determined from the respective product of the entries in column 
C and G. 

Total Weight 
The final column indicates the total weight of each part. 

Sum 
At the bottom of the list, you find a summary of the values in the columns B, D, E, F, and I. The 
last row of the Total Weight column informs you about the total amount of the required steel. 

4.9 Parts List by Set of Members 

 
Figure 4.10: Window 4.2 Parts List by Set of Members 

The final results window is displayed if you have selected at least one set of members for de-
sign. It summarizes entire structural groups (for example, a horizontal beam) in a parts list. 

The columns are described in the previous chapter. If different cross-sections are used in the 
set of members, the program averages the surface area, volume, and cross-section weight. 



5  Evaluation of Results 

 

 30 Program STEEL Plastic © 2014 Dlubal Software GmbH 

 

5.  Evaluation of Results 
You can evaluate the design results in different ways. The buttons below the upper table can 
help you evaluate the results. 

 
Figure 5.1: Button for evaluation of results  

The buttons have the following functions: 

Button Description Function 

 Result combination 
Creates a new result combination from the governing 
load cases and load combinations  

 Color bar 
Shows or hides the colored reference scales in the re-
sults windows 

 

Filter parameters 
Represents the criterion for filtering the tables:  
Design ratios greater than 1, maximum value, or user-
defined limit 

 Apply filter 
Shows only rows where the filter parameters are valid 
(ratio > 1, maximum, user-defined value) 

 Result diagrams 
Opens the dialog box Result Diagram on Member 
 Chapter 5.2, page 33 

 Excel export 
Exports the table to MS Excel / OpenOffice 
 Chapter 7.4.2, page 44 

 Member selection 
Allows for the graphical selection of a member to dis-
play its results in the table 

 View mode Goes to the RSTAB work window for changing the view 

Table 5.1: Buttons in the results windows 2.1 through 2.5 
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5.1 Results on the RSTAB model 
You can also evaluate the design results in the RSTAB work window. 

RSTAB background graphic and view mode 
The RSTAB work window in the background is useful for finding the position of a member in 
the model. The member selected in the STEEL Plastic results window is highlighted in the se-
lection color in the background graphic. Furthermore, an arrow indicates the member's x-
location displayed in the currently selected table row. 

 

Figure 5.2: Indication of the member and the current Location x in the RSTAB model 

If you cannot improve the display by moving the STEEL Plastic window, click [Jump to Graphic] 
to activate the View Mode. Thus, you hide the module window so that you can change the dis-
play in the RSTAB graphical user interface. In the view mode, you can use the functions of the 
View menu, for example zooming, moving, or rotating the display. The indication arrow remains 
visible. 

To return to the STEEL Plastic module, click [Back]. 

RSTAB work window 
You can also graphically check the design ratios in the RSTAB model. First, click [Graphics] to 
exit the design module. In the RSTAB work window, the design ratios are now displayed like 
the internal forces of a load case. 

To display or hide design results, use the [Show Results] button known from the display of in-
ternal forces. To display the result values, click the [Show Values] button in the toolbar to the 
right. 

The RSTAB tables are of no relevance for the evaluation of design results. 

To set the design cases, you can use the list in the toolbar. 
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To adjust the results display, use the Display navigator below the entry Results → Members. The 
display of the design ratios is Two-Colored by default. 

 

Figure 5.3: Display navigator: Results → Members 

When you select a multicolor representation (options With/Without Diagram or Cross-Sections), 
the color scale panel becomes available. It provides the common control functions described 
in the RSTAB manual, Chapter 3.4.6. 

 

Figure 5.4: Design ratios with display option Without Diagram 

You can transfer the graphics of the results to the printout report (see Chapter 6.2, page 36). 

To return to the add-on module, click [STEEL Plastic] in the panel. 
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5.2 Result Diagrams 
You can also graphically evaluate a member's result distributions in a result diagram. 

To do this, select the member (or set of members) in the STEEL Plastic results window by click-
ing in the corresponding table row of the member. Then, open the Result Diagram on Member 
dialog box by clicking the button shown on the left. The button is located below the upper re-
sults table (see Figure 5.1, page 30). 

To display the result diagrams, select the command from the RSTAB menu 

Results → Result Diagrams for Selected Members 

or use the button in the RSTAB toolbar shown on the left. 

A window opens, graphically presenting the distribution of the maximum design values on the 
member or set of members. 

 
Figure 5.5: Dialog box Result Diagram on Member 

To select the relevant STEEL Plastic design case, use the list in the toolbar of the dialog box. 

The Result Diagram on Member dialog box is described in the RSTAB manual, Chapter 9.5. 
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5.3 Filter for Results 
The results windows in STEEL Plastic allow you to sort the results by various criteria. In addi-
tion, you can use the filter options to graphically evaluate the results as described in Chapter 
9.7 of the RSTAB manual. 

In STEEL Plastic, you can also use the Visibilities (see RSTAB manual, Chapter 9.7.1) to filter the 
members for evaluation. 

Filtering designs 
The design ratios can easily be used as filter criteria in the RSTAB work window which you can 
access by clicking [Graphics]. To apply this filter function, the panel must be displayed. If it is 
not, select in the RSTAB menu 

View → Control Panel (Color Scale, Factors, Filter) 

or use the toolbar button shown on the left. 

The panel is described in the RSTAB manual, Chapter 3.4.6. You define the filter settings for the 
results in the first panel tab (Color spectrum). Because this register is not available for the two-
colored results display, you have to use the Display navigator  and set the display options  
With/Without Diagram or Cross-Sections first. 

 
Figure 5.6: Filtering design ratios with adjusted color spectrum 

As the figure above shows, the color spectrum can be set in such a way that only ratios higher 
than 0.50 are shown in a color range between blue and red. 

If you select the Display Hidden Result Diagram option in the Display navigator (Results→ Mem-
bers), you can display all design ratio diagrams that are not covered by the color spectrum. 
Those diagrams will be represented by dotted lines.  
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Filtering members 
In the Filter tab of the control panel, you can specify the numbers of particular members to 
display their results exclusively, that is, filtered. This function is described in the RSTAB manual, 
Chapter 9.7.3. 

 

Figure 5.7: Member filter for the design ratios of a frame 

Unlike the partial view function (Visibilities), the graphic displays the entire model. The figure 
above shows the design ratios of a frame. The remaining members are displayed in the model 
but are shown without design ratios. 
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6.  Printout 
 

6.1 Printout Report 
Like in RSTAB, the program generates a printout report for the STEEL Plastic results, to which 
you can add graphics and descriptions. The selection in the printout report determines which 
data from the design module will be included in the final printout. 

The printout report is described in the RSTAB manual. In particular, Chapter 10.1.3.5 Selecting 
Data of Add-on Modules describes how to select input and output data from add-on modules 
for the printout report. 

For large structural systems with many design cases, it is recommended to split the data into 
several printout reports, thus allowing for a clearly-arranged printout. 

6.2 Graphic Printout 
In RSTAB, you can add every picture displayed in the work window to the printout report or 
send it directly to a printer. In this way, you can also prepare the design ratios displayed on the 
RSTAB model for the printout. 

Printing graphics is described in the RSTAB manual, Chapter 10.2. 

Designs on the RSTAB Model 
To print the current graphic of the design ratios, select the command in the menu 

File → Print 

or use the toolbar button shown on the left.  

 
Figure 6.1: Button [Print Graphic] in RSTAB toolbar 

Result diagrams  
In the Result Diagram on Member dialog box, you can also send the graphic with the design 
values to the report using the [Print] button. Furthermore, you can print the graphic directly. 

 
Figure 6.2: Button [Print] in the dialog box Result Diagram on Member 

The following dialog box appears. 
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Figure 6.3: Dialog box Graphic Printout, tab General 

This dialog box is described in the RSTAB manual, Chapter 10.2. The manual also describes the 
Options and Color Scale tab. 

To move a graphic within the printout report, use the drag-and-drop function. 

To adjust a graphic in the printout report after the fact, right-click the corresponding entry in 
the navigator of the printout report. The Properties option in the context menu opens the 
Graphic Printout dialog box, offering various options for adjustment. 

 
Figure 6.4: Dialog box Graphic Printout, tab Options 
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7.  General Functions 
This chapter describes useful menu functions and export options for the designs. 

7.1 Design Cases 
Design cases allow you to group members for the design. In this way, you can consider groups 
of structural components or analyze members with particular design specifications (for exam-
ple, changed materials, partial safety factors, or optimization). 

It is no problem to analyze the same member or set of members in different design cases. 

To calculate a STEEL Plastic design case, you can also use the load case list in the RSTAB 
toolbar. 

Creating new design case 
To create a new design case, select in the STEEL Plastic menu 

File → New Case. 

The following dialog box appears: 

 
Figure 7.1: Dialog box New STEEL Plastic Case 

In this dialog box, enter a No. (one that is still available) for the new design case. An appropri-
ate Description will make the selection in the load case list easier. 

Click [OK] to open the 1.1 General Data window of STEEL Plastic where you can enter the de-
sign data. 

Renaming design case 
To change the description of a design case, select in the STEEL Plastic menu 

File → Rename Case. 

The following dialog box appears: 

 
Figure 7.2: Dialog box Rename STEEL Plastic Case 

In this dialog box, you can specify a different Description as well as a different No. for the 
design case. 
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Copying design case 
To copy the input data of the current design case, select from the STEEL Plastic menu 

File → Copy Case. 

The following dialog box appears: 

 
Figure 7.3: Dialog box Copy STEEL Plastic 

Define the No. and, if necessary, a Description for the new case. 

Deleting design case 
To delete design cases, select from the STEEL Plastic menu 

File → Delete Case. 

The following dialog box appears: 

 
Figure 7.4: Dialog box Delete Case 

First, select the design case from the Available Cases. To delete the selected case, click [OK]. 
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7.2 Cross-Section Optimization 
The design module offers you the option to optimize overstressed or little utilized cross-
sections. To do this, select from the lists in column D or E of the 1.3 Cross-Sections window 
whether to determine the cross-section From current row or from the user-defined Favorites 
(see Figure 2.6, page 12). Alternatively, you can start the cross-section optimization in the  
results windows by using the context menu. 

 
Figure 7.5: Context menu for cross-section optimization 

During the optimization process, the module determines the cross-section that fulfills the de-
sign conditions in the most optimal way, that is, comes as close as possible to the maximum  
allowable design ratio specified in the Details dialog box (see Figure 3.2, page 17). The required 
cross-section properties are determined with the internal forces from RSTAB. If another cross-
section proves to be more favorable, this new cross-section is used for the design. Then, the 
graphic in Window 1.3 shows two cross-sections: the original cross-section from RSTAB and 
the optimized one (see Figure 7.7). 

For a parametric cross-section, the following dialog box appears when you select 'Yes' from 
the drop-down list. 

 
Figure 7.6: Dialog box Welded Cross-Sections - Symmetric I-Section : Optimize 

By selecting the check boxes in the Optimize column, you decide which parameter(s) you want 
to modify. This enables the Minimum and Maximum columns, where you can specify the upper 
and lower limits of the parameter. The Increment column specifies the interval by which the 
size of the parameter varies during the optimization process. 
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If you want to Keep current side proportions, select the corresponding check box. In addition, 
you must select at least two parameters for optimization. 

Cross-sections built up from rolled cross-sections cannot be optimized. 

Please note that the internal forces will not be recalculated automatically with the changed 
cross-sections in the optimization. It is up to you to decide which cross-sections you want to 
transfer to RSTAB for recalculation. Due to the changed stiffnesses in the structural system, the 
internal forces from the optimized cross-section may vary significantly. Therefore, it is recom-
mended to recalculate the internal forces of the modified cross-section data after the first op-
timization, and then to optimize the cross-sections once again. 

You can export the modified cross-sections to RSTAB. To do this, go to the 1.3 Cross-Sections 
window, and then select the command from the menu 

Edit → Export All Cross-Sections to RSTAB. 

Alternatively, you can use the context menu in Window 1.3 to export optimized cross-sections 
to RSTAB. 

 
Figure 7.7: Context menu in Window 1.3 Cross-Sections 

Before the modified materials are transferred to RSTAB, a query appears as to whether you 
want to delete the results in RSTAB and STEEL Plastic.  

 
Figure 7.8: Query before export of modified cross-sections to RSTAB 

By confirming the query, and then starting the [Calculation] in the STEEL Plastic module, the 
RSTAB internal forces as well as the checks will be determined in a single calculation run. 

If the modified cross-sections are not exported to RSTAB, you can reimport the original cross-
sections in the design module by using the options shown in Figure 7.7. Please note that this 
option is available in the 1.3 Cross-Sections window only. 

If you optimize a tapered member, the program modifies the start and end sections of the 
member. Then, the program linearly interpolates the second moments of area at the interme-
diate locations. Because these moments are considered with the fourth power, the analyses 
may be inaccurate if the depths of the start and the end cross-section differ significantly. In 
such a case, it is recommended to divide the taper into several members, thus modeling the 
taper layout manually. 
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7.3 Units and Decimal Places 
Units and decimal places for RSTAB and the add-on modules are managed in one common 
dialog box. To specify the units for STEEL Plastic, select in the module menu 

Settings → Units and Decimal Places. 

The dialog box known from RSTAB appears. In the Program / Module dialog box section, STEEL 

Plastic is preset. 

 
Figure 7.9: Dialog box Units and Decimal Places 

To reuse the settings in other models, save them as a user-profile. These functions are de-
scribed in the RSTAB manual, Chapter 11.1.3.     
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7.4 Data Exchange 

7.4.1 Exporting Materials to RSTAB 

If you adjusted the materials in STEEL Plastic for design, you can export the modified materials 
to RSTAB in a similar way as you export cross-sections. To do this, go to the 1.2 Materials win-
dow, and then select the command in the menu 

Edit → Export All Materials to RSTAB. 

Alternatively, you can export the modified materials to RSTAB by using the context menu in 
Window 1.2. 

 
Figure 7.10: Context menu of Window 1.2 Materials 

Before the modified materials are transferred to RSTAB, a query appears as to whether you 
want to delete the results in RSTAB. After you confirm the query and start the [Calculation] in 
STEEL Plastic, the RSTAB internal forces and designs are determined in a single calculation run. 

If the modified materials are not exported to RSTAB, you can transfer the original materials to 
the design module, using the options shown in Figure 7.10. Please note, however, that this op-
tion is only available in the 1.2 Materials window. 

7.4.2 Exporting Results 

You can use the STEEL Plastic results also in other programs. 

Clipboard 
To copy cells selected in the results windows to the Clipboard, press the keys [Ctrl]+[C]. To in-
sert the cells, for example in a word processor, press [Ctrl]+[V]. The headers of the table col-
umns are not transferred. 

Printout report 
You can print the data of the STEEL Plastic module into the printout report (see Chapter 6.1, 
page 36) for export. Then, in the printout report, you can export them by selecting in the re-
port menu 

File → Export in RTF. 

This function is described in the RSTAB manual, Chapter 10.1.11. 

Excel / OpenOffice 
STEEL Plastic provides a function for the direct data export to MS Excel, OpenOffice.org Calc,  
or the file format CSV. To open the corresponding dialog box, select on the module menu 

File → Export Tables. 

The following dialog box appears. 
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Figure 7.11: Dialog box Export - MS Excel 

Having selected the relevant options, you can start the export by clicking [OK]. Excel or 
OpenOffice are started automatically, that is, you do not need to open the programs before-
hand. 

 
Figure 7.12: Results in Excel 
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8.  Worked Examples 
 

8.1 Doubly Symmetrical I-Section 
The following example is presented in [1], page 431. The interaction from axial force and 
double-bending without warping is analyzed according to PIFM. 

Cross-Section 
Doubly symmetrical I-section HE B 200  

Steel S 235 

 
Figure 8.1: Doubly symmetrical I-section HE B 200 

Cross-section properties 

Cross-section property Symbol Value Unit 

Depth h 200.00 mm 

Width b 200.00 mm 

Web thickness tw 9.00 mm 

Flange thickness tf 15.00 mm 

Root fillet radius r 18.00 mm 

Depth between flanges d-2tf 170.00 mm 

Depth of straight web d 134.00 mm 

Cross-sectional area A 78.08 cm2 

Shear area Ay 50.03 cm2 

Shear area Az 15.32 cm2 

Effective shear area according to EC 3 Av,y 62.43 cm2 

Shear area according to EC 3 Av,z 24.83 cm2 

Plastic shear area Apl,y 60.00 cm2 

Plastic shear area Apl,z 16.65 cm2 

Moment of inertia Iy 5696.00 cm4 

Moment of inertia Iz 2003.00 cm4 

Governing radius of gyration ry 85.40 mm 

Governing radius of gyration rz 50.70 mm 

Polar radius of gyration ro 99.30 mm 

Radius of gyration of flange section plus 1/5 of web area rzg 53.90 mm 
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Volume V 7808.00 cm3/m 

Weight wt 61.30 kg/m 

Surface Asurf 1.15 m2/m 

Section factor Am/V 147.285 1/m 

Torsional constant J 59.28 cm4 

Warping constant Cw 171,100.00 cm6 

Elastic section modulus Sy 569.60 cm3 

Elastic section modulus Sz 200.30 cm3 

Warping section modulus Ww 1849.73 cm4 

Statical moment of area Qy,max 321.25 cm3 

Statical moment of area Qz,max 75. 00 cm3 

Normalized warping constant Wno 92.50 cm2 

Warping statical moment Qw 693.75 cm4 

Plastic section modulus Zy 642.50 cm3 

Plastic section modulus Zz 305.80 cm3 

Plastic warping section modulus Zw 2775.00 cm4 

Plastic shape factor Ζy/Sy 1.128 
 

Plastic shape factor Ζz/Sz 1.527 
 

Plastic shape factor Ζw/Ww 1.500  

Table 8.1: Cross-section properties HE B 200 

Loading 
Axial force  NEd = 1000.00 kN 

Moment Mz,Ed = 26.20 kNm 

Moment My,Ed = 34.50 kNm 
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8.1.1 Check of Allowable Bending Moment in Top Flange 

 
Figure 8.2: Check of the allowable bending moment at top flange 

Material properties 

 

 

 

 

Partial internal forces in cross-section parts according to [1], Table 10.9 

 

 

 

 

 

Limiting plastic internal forces according to [1], Table 10.9 
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Check according to [1], Table 10.9 

 

 

 

 

8.1.2 Check of the Allowable Axial Force 

 
Figure 8.3: Check of the allowable axial forces 

Limiting plastic internal forces according to [1], Table 10.8 
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8.1.3 Check of the Allowable Bending Moment 

 
Figure 8.4: Design of the allowable bending moment about major axis 

Governing case according to [1], Table 10.8 

    Case 3: 

 

 

 

Limiting plastic internal forces [1], Table 10.8 

 

 

 

 

Check according to [1], Table 10.8 
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8.2 Monosymmetrical I-Section 
The following example is presented in [1], page 190 f. The interaction from double-bending 
with shear force but without taking account of bimoment Mω is analyzed. 

Cross-Section 
Monosymmetrical I-Section IU 432/300/20/12/180/12 

Steel S 235 

 
Figure 8.5: Monosymmetrical I-Section IU 432/300/20/12/180/12 

Cross-section properties 

Cross-section property Symbol Value Unit 

Depth h 432.000 mm 

Upper flange width bt 300.000 mm 

Upper flange thickness tt 20.000 mm 

Web thickness s 12.000 mm 

Lower flange width bb 180.000 mm 

Lower flange thickness tb 12.000 mm 

Upper fillet web thickness at 6.000 mm 

Lower fillet web thickness ab 6.000 mm 

Cross-sectional area A 129.600 cm2 

Shear area Ay 81.600 cm2 

Shear area Az 48.000 cm2 

Distance to center of gravity ez 157.100 mm 

Moment of inertia Iy 36,923.100 cm4 

Moment of inertia Iz 5088.960 cm4 

Polar moment of inertia Ip 42,012.000 cm4 

Polar moment of inertia Ip,M 54,783.600 cm4 

Moment of inertia referred to the smaller flange Iy,SF 37,271.600 cm4 

Governing radius of gyration ry 168.800 mm 

Governing radius of gyration rz 62.700 mm 

Polar radius of gyration ro 180.000 mm 

Polar radius of gyration rp,M 205.700 mm 

Weight wt 101.700 kg/m 
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Surface Asurf 1.800 m2/m 

Torsional constant J 110.530 cm4 
Distance from the shear center to the center of 
gravity S zM -99.300 mm 

Warping constant referring to M Cw 893,470.000 cm6 

Fade factor λ 0.001 1/mm 

Elastic section modulus Sy,max 1343.200 cm3 

Elastic section modulus Sy,min -2350.120 cm3 

Elastic section modulus Sz 339.260 cm3 

Warping section modulus Ww 2696.510 cm4 

Statical moment of area Qy,max 995.460 cm3 

Statical moment of area Qz,max 224.910 cm3 

Normalized warping constant Wno 331.340 cm2 

Warping statical moment Qw 1789.250 cm4 

Stability parameter according to Kindem ry,Kindem 87.000 mm 

Stability parameter rM,z 285.500 mm 

Location of area center line fz -97.100 mm 

Plastic section modulus Zy 1877.760 cm3 

Table 8.2: Cross-section properties IU 432/300/20/12/180/12 

Material properties 
 

 

 

 

Loading 
Shear force Vz,Ed = 121.67 kN 

Shear force Vy,Ed = 28.28 kN 

Moment Mz,Ed = -62.45 kNm 

Moment My,Ed = 271.59 kNm 
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8.2.1 Transformation of Internal Forces 

 

Figure 8.6: Transformation of internal forces in reference coordinate system according to [1], Table 10.16 
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8.2.2 Shear Resistance in Top Flange 

 
Figure 8.7: Check of shear resistance in top flange 

Partial internal forces in cross-section parts according to [1], Table 10.17 

 

Figure 8.8: Internal forces τ in cross-section consisting of three plates acc. to Figure 10.40 [1] 
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Limiting plastic internal forces according to [1], Table 10.17 

 

 

  

 

 

 

 

 

Check according to [1], Table 10.17 

 

 

 

 

 

 

 

8.2.3 Shear Resistance in Web 

 
Figure 8.9: Check of shear resistance in web 
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Partial internal forces in cross-section parts according to [1], Table 10.17 

 

Figure 8.10: Partial internal forces τ in cross-section consisting of three plates according to Figure 10.40 [1]  

 

 

Limiting plastic internal forces according to [1], Table 10.17 

 

 

  

 

 

 

 

 

 

Check according to [1], Table 10.17 
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8.2.4 Shear Resistance in Bottom Flange 

 
Figure 8.11: Check of shear resistance in top flange 

Partial internal forces in cross-section parts according to [1], Table 10.17 

 

Figure 8.12: Partial internal forces τ in cross-section consisting of three plates according to Figure 10.40 [1]  
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Limiting plastic internal forces according to [1], Table 10.17 

 

 

  

 

 

 

 

 

 

Check according to [1], Table 10.17 
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8.2.5 Check of Allowable Bending Moment in Top Flange 

 
Figure 8.13: Check of the allowable bending moment at top flange 

Partial internal forces in cross-section parts according to [1], Table 10.20 

 

 

 

 

 

 
Limiting plastic internal forces according to [1], Table 10.20 

 

 

  

 

 

Check according to [1], Table 10.9 

 

 

 



8  Worked Examples 

 

 

 

59 Program STEEL Plastic © 2014 Dlubal Software GmbH 

kNm21.21kNcm58.2120M
4

0.1824.471
M

4

bN
M

,b,pl

,b,pl

b,b,pl
,b,pl

==

⋅
=

⋅
=

τ

τ

τ
τ

( )
( )

( )
( )

kNcm49.716M

0.216.20
339,101)0.21(6245

M

zz

MzM
M

b,Sa

b,Sa

tb

tz
b,Sa

−=
+

+−⋅
=

−
+⋅−

= ω

( )
kN24.471N

012.0182.212.10.18N

1ftbN

,b,pl

2
,b,pl

2

Rd

b
d,ybb,b,pl

=

−⋅⋅⋅=









τ
τ

−⋅⋅⋅=

τ

τ

τ

00.1338.0
58.2120

49.716

cm0.0by21
M

M
bbb

2
b

,b,pl

b,Sa

≤=
−

=⋅=δ⇒δ+≤
τ

8.2.6 Check of Allowable Bending Moment in Bottom Flange 

 
Figure 8.14: Check of allowable bending moment in bottom flange 

Partial internal forces in cross-section parts according to [1], Table 10.20 

 

 

 

 

 

 
Limiting plastic internal forces according to [1], Table 10.20 

 

 

  

 

 

Check according to [1], Table 10.9 

 

 

 

 



8  Worked Examples 

 

 60 Program STEEL Plastic © 2014 Dlubal Software GmbH 

 

( )
kN52.864NkN52.864N

563.010.00.087.1308N

M

M
1NN

0.02563.0
M

M

max,tlim,min,tlim,

2
min,tlim,

,t,pl

t,Sa2
tt,t,plmin,tlim,

t
,t,pl

t,Sa

=⇒−=

−+−−⋅=

























−+δ−δ−⋅=

=δ⋅≥=

τ
τ

τ

( )
kN45.383NkN45.383N

339.010.00.024.471N

M

M
1NN

0.02339.0
M

M

max,blim,min,blim,

2
min,blim,

,b,pl

b,Sa2
bb,b,plmin,blim,

t
,b,pl

b,Sa

=⇒−=

−+−−⋅=

























−+δ−δ−⋅=

=δ⋅≥=

τ
τ

τ

kN85.1025N

201.0182.212.10.40N

1fthN

max,wlim,

2
max,wlim,

2

Rd

w
d,ywwmax,wlim,

=

−⋅⋅⋅=









τ
τ

−⋅⋅⋅=

8.2.7 Check of Allowable Bending Moment  

 
Figure 8.15: Check of allowable bending moment about major axis 

Limiting axial forces in flanges according to [1], Table 10.18 

 

 

 

 

 

 

 

 

 

 

 

 

 

Limiting axial force according to [1], Table 10.20 
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Governing case according to [1], Table 10.19 

Because N = 0, all possible cases for determining max My are met. Therefore, the limiting bend-
ing moments are determined for all three cases. The minimum value is governing. 

• Case 1: 

 

 

 

 

• Case 2: 

 

 

 

 

 

 

 

 

• Case 3: 

 

 

 

 

Check according to [1], Table 10.19 
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8.3 Circular Hollow Section 
The following example is presented in [1], page 446. 

Cross-section 
Cross-section pipe 273/8 

Steel S 235 

 
Figure 8.16: Cross-section pipe 273/8 

Cross-section properties 

Cross-section property Symbol Value Unit 

Outer diameter D 273.000 mm 

Wall thickness s 8.000 mm 

Cross-sectional area A 66.600 cm2 

Shear area Ay 33.040 cm2 

Core area Ac 551.550 cm2 

Moment of inertia Iy 5851.710 cm4 

Polar moment of inertia Ip 8275.570 cm4 

Governing radius of gyration ry 93.700 mm 

Polar radius of gyration ro 132.600 mm 

Weight wt 52.300 kg/m 

Surface Asurf 0.858 m2/m 

Torsional constant J 11,692.800 cm4 

Section modulus for torsion St 856.610 cm3 

Elastic section modulus Sy 428.700 cm3 

Statical moment of area Qy,max 140.490 cm3 

Plastic section modulus Zy,max 561.970 cm3 

Table 8.3: Cross-section properties for pipe 273/8 
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Loading 
Shear force VEd = 116.00 kN 

Moment MT,Ed = 40.00 kNm 

Moment My,Ed = 100.00 kNm 

8.3.1 Check of Shear Resistance 

 
Figure 8.17: Check of shear resistance 

Material properties 

 

 

 

 

Limiting plastic internal forces according to [1], Table 10.10 
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Check according to [1], Table 10.10 

The check conditions given in Table 10.10 apply to the linear interaction. In STEEL Plastic, how-
ever, the iterative method of the exact solution is implemented. Thus, you obtain higher re-
sistances for this example than given in [1]. 

 
Figure 8.18: Mx-V interaction (exact solution and approximations) 

Linear interaction 

 

 

 

 

 

 

Exact solution 
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8.3.2 Interaction of Normal and Bending Stresses 

 
Figure 8.19: Interaction check of normal and bending stresses 

Reduction factor of yield strength 

 

 

 

 

Limiting plastic internal forces according to [1], Table 10.10 

 

 

 

 

 

 

 

Check according to [1], Table 10.10 
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8.4 Rectangular Hollow Section 
The following example is presented in [1], page 458. 

Cross-section 
Rectangular hollow section TO 300/200/8 

Steel S 355 

 

Figure 8.20: Rectangular hollow section TO 300/200/8 

Cross-section properties 

Cross-section property Symbol Value Unit 

Depth a 300.000 mm 

Width b 200.000 mm 

Left wall thickness tal 8.000 mm 

Right wall thickness tar 8.000 mm 

Upper wall thickness tbt 8.000 mm 

Lower wall thickness tbb 8.000 mm 

Cross-sectional area A 77.440 cm2 

Shear area Ay 22.840 cm2 

Shear area Az 41.800 cm2 

Core area Ac 560.640 cm2 

Moment of inertia Iy 9877.000 cm4 

Moment of inertia Iz 5256.840 cm4 

Polar moment of inertia Ip 15,133.800 cm4 

Governing radius of gyration ry 112.900 mm 

Governing radius of gyration rz 82.400 mm 

Polar radius of gyration ro 139.800 mm 

Weight wt 60.800 kg/m 

Surface Asurface 1.000 m2/m 

Torsional constant J 10,407.200 cm4 

Warping constant referring to M Cw 21,647.200 cm6 
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Elastic section modulus Sy 658.470 cm3 

Elastic section modulus Sz 525.680 cm3 

Warping section modulus Ww 747.520 cm4 

Statical moment of area Qy,max 197.460 cm3 

Statical moment of area Qz,max 149.060 cm3 

Normalized warping constant Wno 28.960 cm2 

Warping statical moment Qw,max 149.810 cm4 

Plastic section modulus Zy,max 789.820 cm3 

Plastic section modulus Zz,max 596.220 cm3 

Plastic shape factor Ζy,max/S_y 1.199 
 

Plastic shape factor Ζz,max/S_z 1.134  

Table 8.4: Cross-section properties TO 300/200/8 

Loading 

Shear force  VEd  = 48.00 kN 

Moment  MT,Ed = 24.00 kNm 

Moment  My,Ed = 240.00 kNm 

8.4.1 Shear Resistance in Flanges 

 
Figure 8.21: Check of shear resistance in flanges 

Material properties 
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Limiting plastic internal forces according to [1], Table 10.14 

 

 

  

 

 

 Partial internal forces in cross-section parts 

 

 

 

 

 

Check according to [1], Table 10.14 
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8.4.2 Shear Resistance in Web 

 
Figure 8.22: Check of shear resistance in web 

Check according to [1], Table 10.14 
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8.4.3 Interaction of Normal and Bending Stresses 

 
Figure 8.23: Interaction check of normal and bending stresses 

Reduction factors of yield strength according to [1], Table 10.15 

 

 

 

 

 

Limiting plastic internal forces according to [1], Table 10.15 

 

 

 

 
Check according to [1], Table 10.15 – case 1a 
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